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End-use parts include all components, sub-assemblies and products from any manufacturing process. These parts  
are the output of both series production and custom manufacturing.

Additive manufacturing is emerging as a viable option to molding, machining, forming and casting of end-use parts. 
These traditional processes generally rely on tools and dies when production volumes are moderate or high. For low 
quantities, conventional approaches often rely on manual or semi-automated machining, forming and fabrication. 

FDM, an additive manufacturing technology, eliminates tools and dies while automating the production process.  
Substituting FDM for the traditional manufacturing processes will substantially reduce lead times and costs. It also 
makes production a simple, unattended and virtually labor-free operation. 

For those willing to break free of the status quo, FDM creates new design opportunities. Parts can be designed for 
optimal performance and ergonomics since additive manufacturing places few constraints on design configurations. 
And designs are fluid. There is no investment in tooling, so part configurations can change with each production run.
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1. OVERVIEW

1.1. Application:

FDM is an alternative manufacturing method for end-use parts including 
finished goods and sub-assemblies. It may be substituted for processes 
that use molding, machining, casting and forming.

1.2. FDM is a best fit when:

•	 Complex designs.

 − Feature-laden.

 − Organic, flowing shapes.

 − Consolidated assemblies.

•	 Small to moderate size.

 − Ideal (but smaller or larger are possible):

 à > 1 in. x 1 in. x 1 in. (25 mm x 25 mm x 25 mm)

 à < 16 in. x 14 in. x 16 in. (405 mm x 355 mm x 405 mm)

 − Low-volume or custom manufacturing.

 − Pilot, bridge and full production.

 − Quantities:

 à Dependent on part size and volume (inverse relationship).

 à Typically 1 to 1000 pieces.

•	 Many product revisions or variations.

 − Use when design modifications and iterations are likely.

 − Use when there are a large number of configuration options 
for a small volume of products.

•	 Materials are compatible.

 − Thermoplastic materials—confirm suitability of mechanical 
properties, electrical properties, chemical resistance and 
thermal resistance.

•	 Accuracy is suitable.

 − Without secondary machining, use with applications that 
require tolerances of 0.005 in. (0.13 mm) or higher.

 − In many cases, secondary machining can be used to improve 
the accuracy for higher tolerance requirements.

2. ROLES & STRATEGIES

This guide presents tips and techniques that leverage the advantages of 
FDM while optimizing part quality and operational efficiency. The degree 
to which these are applied is dependent on the role that the end-use 
parts will play. If used as an interim, stopgap solution, minor adjustments 
may be all that is warranted. On the other hand, if FDM will be the long-
term production process, any time invested in design and preparation will 
be justified by the gains in quality and productivity. 

Figure 1: Processing equipment component – 
customized for each

Figure 2: Electronic surveillance equipment 
includes FDM housing.

Figure 3: MRI head coil required compatible 
materials.

Figure 4: Bezel for pharmacy equipment.
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2.1. Pilot production (Figure 6).

FDM is the short-term solution for end-use part production. After the 
pilot is complete, parts are produced through a traditional manufacturing 
process. In this capacity, design modifications are undesirable and gains 
from process refinement are short-lived.

For the pilot production, use the part design that suits the conventional 
production method. The “freedom of design” that additive manufacturing 
offers means that changes may be unnecessary.

•	 Leave part design unchanged.

•	 Make minor process adjustments.

2.2. Bridge-to-production.

In this role, FDM is an interim solution used to bridge the time span 
between product launch and production line start-up. For example,  
FDM could be used to produce parts while awaiting delivery of an 
injection mold.

Since production will be handed off to a traditional manufacturing 
process, design alterations are not desirable. However, if the time span 
and production quantity are significant, minor design alterations may be 
incorporated. This production quantity is also likely to warrant a larger 
upfront investment of time in optimizing FDM build parameters.

•	 Consider minor design changes.

•	 Tune process to optimize performance.

2.3. Full production (Figure 7).

When FDM will be the only method of end-use part production, optimize 
every aspect of the part and its production. This investment will maximize 
product performance and throughput while minimizing cost. 

Optimization includes designing the part purely for its function; ignore 
established design for manufacturability rules.

•	 Complete redesign is justifiable.

•	 Fine-tune process for maximum optimization.

•	 Continue to redesign throughout the product life cycle.

3. DESIGN FOR FUNCTION (CAD)

A simple approach to apply FDM to end-use part manufacturing is to 
use existing designs and current design rules. However, this may be 
an inefficient approach that does not capitalize on the advantages of 
additive manufacturing. If left unchanged, the rules that govern designs 
for conventional processes are artificially imposed on FDM parts.

Whenever time allows, it is best to start with a fresh design that builds 
from the design freedoms offered by additive processes and optimizes 
part production. 

Figure 6: Pilot production: minor process 
adjustments.

Figure 7: Full production: modify design and 
optimize process.

Figure 5: Gauge pod for custom motorcycle.
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3.1. Integrated design (consolidation). (*) (De)

Convert assemblies into single parts. Components are often dissected 
into many pieces in order to make conventional manufacturing processes 
feasible and affordable (Figures 8 and 9).  This is unnecessary with FDM. 

If reproducing an existing part, start with a redesign that consolidates 
as many components as possible into one piece. If designing a new 
item, create it as one piece (Figure 10); only split off parts when it is 
advantageous to the product’s operation or maintenance.

Integrated design has many advantages, including:

•	 Design for function.

 − Focus on the task that the tool will perform. Optimize the 
design for its function rather than the processes used to make it.

 − Eliminate tolerance challenges.

 à Holding tight tolerances is costly but avoidable. If two 
mating parts are combined into one, all concerns over— 
and all costs for—controlling the tolerances where they 
mate are eliminated.

•	 Eliminate assembly time.

 − Assemblies, obviously, must be assembled, and this takes 
time. Consolidate all parts into a single piece to eliminate the 
time needed for assembly.

•	 Absorb costly neighbors.

 − Look beyond the sub-assembly to find expensive or long lead 
time parts in the vicinity. Including them in the consolidation 
further reduces costs and production time.

•	 Decrease BOM count.

 − Smaller part counts decrease the time and expense for 
managing and warehousing inventory.

3.2. Integrated features. (*) (De)

There are two aspects to integrated features: adding features and 
inserting hardware.

3.2.1. Adding features:

With traditional manufacturing processes there is usually a cost 
associated with every feature added to a part. This is not true with 
additive manufacturing, especially when material is removed. 

In the design of an FDM part, consider adding features that 
improve performance, reduce build times and reduce material 
costs. For example:

•	 Add pockets, channels and holes (Figure 13).

 − Removing mass from the part will decrease weight, 
material consumption and build time, in most cases.

Figure 8: Assembly drawing for a manufactured tool.

Figure 9: Machined tool made of over two 
dozen parts.

Figure 10: Redesigned FDM tool consolidates 
most components.

Figure 11: Original design – single component.

Figure 12: Consolidated design – integrated 
mounting flange.
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•	 Add ribs, bosses and gussets.

 − There will be a slight (in most cases) increase in build 
time and material cost. However, the impact is far less 
than that of a traditional process when the feature 
adds a tool change, setup or side pull.

•	 Add embellishments (Figure 14).

 − Incorporate part numbers, storage locations, 
alignment aids or operational instructions directly on 
the part.

3.2.2. Inserting hardware (Figures 15 - 17): 

As with traditional manufacturing, hardware may be added in a 
secondary operation. For example, threaded inserts can be press-
fit into location holes added to the CAD model or machined after 
the FDM part has been built.

Another alternative is to mimic insert molding. In the CAD model, 
add a pocket or hole that will contain a sensor, RFID tag, bushing 
or threaded insert. During the FDM build process, pause the job, 
place the item in the part, and resume the build. The hardware is 
now integrated with the FDM part.

3.3. Maximize fill density. (**) (St)

FDM parts use an internal raster fill bounded by external contours. For 
thin features—those less than 0.060 in. (1.52 mm)—there may not be 
enough space for the internal rasters (Figure 18). This may result in an 
internal void. These voids may be eliminated in Insight (see Section 5.3) or 
prevented in CAD.

In the CAD model, avoid tapers or draft angles for the thin-walled 
features. Since FDM uses a continuous, fixed-width extrusion for each 
curve, the gradual change in width will yield a void. 

3.3.1. CAD revision (Figure 19).

To prevent these gaps, make the feature thickness constant in the 
XY plane. The thickness may vary at different Z elevations, but 
do so with discrete, stepped changes rather than having gradual 
changes (e.g., from a draft angle).

3.3.2. Optional revision.

Create each feature such that its wall thickness is an even multiple 
of the contour width (see Section 5.4.2 for details) that will be used 
to make the part. If modeled in this fashion, the feature will not 
require a custom group to have full density. 

Figure 13: Three design options – adding 
features improves performance while 
decreasing time and expense.

Figure 14: Add embellishments to end-use 
parts, such as part numbers.

Figure 15: Fasteners may be added to  
FDM parts.

Figure 16: Integrated bushing adding while 
part is building.

Figure 17: Threaded insert may be added 
during FDM builds or in secondary operations.

Figure 18: Thin-walled features with taper, may 
have air gaps between contours.
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3.4. Self-supporting angles. (***) (Ti)

Supports are added to the bottom of a part and to all features with 
an angle, as measured from the XY plane, that is less than the Self-
supporting angle in Insight (Figure 20). Since supports increase build 
times and material expense, it is advantageous to minimize them. One 
option to do so is to modify the CAD model.

3.4.1. Identify features (Figures 21 and 22).

The default Self-supporting angle ranges 
from 40° to 45°. Review the model to identify 
any features that are near this angle and can be 
modified.

3.4.2. Adjust features.

Alter the design of the identified features by 
increasing the angle such that it is > 45° from the 
XY plane. For features less than 0.25 in. (6.3 mm) 
wide in the XY plane, a cylindrical profile may be 
used (Figure 23). 

Alternatively, the Self-supporting angle may 
be adjusted in Insight (Support > Setup > 
Advance settings). In general, a 5° to 10° 
adjustment is safe. 

3.5. Variable density. (***) (St, Ti)

A unique characteristic of FDM is that a single part can 
have regions with different build styles. The advantages 
include:

•	 Varying density for optimal strength and weight.

•	 Varying density for optimal time and cost.

To some degree, this can be achieved in Insight by 
using custom groups (Figures 24 and 25). But for 
advanced control, make changes to the CAD model 
such that regions of the part can be processed with 
different toolpath controls (Figures 26 and 27).

3.5.1. Modify CAD model.

3.5.1.1. Create CAD model of part.

Begin with a complete CAD model 
of the part. Next, place the model in 
the same orientation in which it will be 
built. 

To assist with alignment in Insight, add 
a reference feature. Locate this feature 
at 0, 0, 0 and make it slightly taller 
than the part (Figure 28).

Save the model.

Figure 19: CAD revisions produce a constant 
wall thickness that has a solid, dense fill

Figure 20: Insight self-supporting 
angle specifies when support 
structure is needed.

Figure 21: Review CAD model for 
features that may avoid supports. 

Figure 22: Model shows supports 
on back face of part where 
ribbing is below the self-
supporting angle.

Figure 23: With minor alteration 
to rib design, supports are no 
longer needed.

Figure 24: Solid-normal fill 
throughout part.

Figure 25: Sparse – double dense 
fill in narrow section when custom 
groups are used.
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3.5.1.2. Extract first region.

Extract the first variable density region from the CAD 
model and delete the balance (Figure 29). Note that the 
reference feature must be retained. 

Export this file as an STL.

3.5.1.3. Extract second region (Figure 30).

Open the original CAD file and extract the second 
region. As with the first, retain the reference feature 
while deleting the balance of the model.

Since Insight will combine curves that appear to overlap, 
adjust this region by offsetting all surfaces that are 
coincident with the first region. A surface offset of 0.001 
in. (0.03 mm) will suffice. 

Export the file as an STL.  Note that a high-resolution 
file is recommended for this and the previous STL. Large 
facets can create regions of overlapping curves between 
parts; these overlapping curves can create problems 
during toolpath generation.  To avoid this problem use 
small facets and visually inspect, in Insight, all layers after 
toolpath generation.

Repeat this step for all other regions of the tool.

3.5.2. Process regions in Insight.

3.5.2.1. Process first region.

Open the STL file for first region (Figure 31). Select the 
model material and slice height and then orient and slice 
the file. Be sure to confirm that the reference feature is 
located at the origin to ensure that all regions will be 
aligned.

Next, apply toolpath settings to achieve the desired 
characteristics for the region.  For example, change the 
Part interior style to Sparse-double dense, but note 
that this must be done through custom groups. 

Now, save the job (File > Save as).

3.5.2.2. Repeat.

For all but the last region, repeat step 3.5.2.1. Note that 
all must use the same Model material, Slice height, and 
orientation. 

3.5.2.3. Process last region.

Open, orient and slice the last STL and apply the desired 
toolpaths by using custom groups.

Save the job (File > Save as) and keep the file open. 
Next, add the previous regions through the Slice > 
Combine slice curve files function. The reference 
feature will force all regions to align to each other  
(Figure 32).

Figure 26: CAD model for part.

Figure 27: Transparency shows two regions for 
variable density.

Figure 28: CAD model with reference feature 
at 0,0,0.

Figure 29: Cross-section showing region 1 with 
region 2 extracted. 

Figure 30: CAD model of region 2 with 
reference feature.
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After all regions have been added, select and delete 
(Edit > Delete > Curves) the curves for all of the 
reference features.

Save the job and continue with the usual file preparation 
procedures.

4. SELECTIONS: MATERIAL AND SLICE

When manufacturing end-use parts with FDM, spend a few minutes 
to consider the options for materials and slice heights. These are the 
first selections made when processing parts in Insight, and they are 
fundamental to product’s performance as well as the efficiency of the 
operation.

Start with the material decision (Figure 34); it is the more important of the 
two, and slice height options are material dependent. Then move on to 
slice height selection.

4.1. Material selection. (*) (Ae, St, Ti)

Criteria:

•	 Material properties (Figure 35).

Consider the operational demands for the part in terms of 
mechanical, thermal, chemical and electrical properties. 

•	 Support material.

FDM offers two support styles: breakaway and soluble. Material 
selection dictates which styles are available. So, consider if the 
advantage of soluble supports—automated, labor-free and few 
concerns over access—are needed. If so, pick a material that uses 
them (Table 1). 

•	 Slice height (Figure 36).

Materials also determine which slice heights are available (Table 
1). Slice height affects surface smoothness and specifies available 
raster and contour widths (see Section 4.2). 

Figure 31: Open first region in Insight.

Figure 32: Combine files for both region 1 (red) 
and region 2 (green).

Figure 33: Result of variable density—solid wall 
section (lower) with Sparse – double dense fill 
in cavity.

Figure 34: Select materials first and then select 
slice height.
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FDM Material Support Style Slice Heights inch (mm)

ABSplus Breakaway  
Soluble

0.005 (0.13) 
0.007 (0.18) 
0.010 (0.25)

ABSi Soluble 0.005 (0.13) 
0.007 (0.18) 
0.010 (0.25) 
0.013 (0.33)

ABS-M30 Soluble 0.005 (0.13) 
0.007 (0.18) 
0.010 (0.25) 
0.013 (0.33)

ABS-M30i Soluble 0.005 (0.13) 
0.007 (0.18) 
0.010 (0.25) 
0.013 (0.33)

PC-ABS Soluble 0.005 (0.13) 
0.007 (0.18) 
0.010 (0.25) 
0.013 (0.33)

PC Breakaway 0.007 (0.18) 
0.010 (0.25) 
0.013 (0.33)

PC-ISO Breakaway 0.007 (0.18) 
0.010 (0.25) 
0.013 (0.33)

PPSF Breakaway 0.010 (0.25) 
0.013 (0.33)*

ULTEM 9085 Breakaway 0.010 (0.25) 
0.013 (0.33)**

Table 1: FDM material options.
* 400mc only
** 900mc only

4.2. Slice selection. (*) (Ae, St, Ti)

Table 1 lists the available slice heights for each of the FDM materials. Slice height specifies the thickness of each 
layer, which affects surface resolution and stairstepping. It also determines which extrusion tip will be used, which in 
turn dictates the range of raster and contour widths (Table 2).

So, this one parameter influences build time, surface quality, feature resolution and even part strength. Therefore, 
this decision must take into account each of these factors.

Slice Height Tip Minimum Toothpath Maximum Toolpath

0.005 (0.13) T10 0.008 (0.20) 0.022 (0.58)

0.007 (0.18) T12 0.012 (0.30) 0.028 (0.73)

 PC & PC-ISO 0.010 (0.25) 0.026 (0.68)

0.010 (0.25) T16 0.016 (0.41) 0.032 (0.83)

 PC-ABS & PC-ISO 0.034 (0.88)

 PPSF & ULTEM 0.030 (0.78)

0.013 (0.33) T20 0.018 (0.46) 0.038 (0.98)

Table 2: Slice height variables. All units in inch (millimeter)

Figure 35: Review FDM material data sheets to 
find the desired properties.

Figure 36: Slice height selection establishes 
which tips to use.
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Thinner slices:

•	 Thinner layers for smoother surfaces.

•	 More layers, which increases build time.

•	 Thinner toolpaths (rasters and contours) for:

 − Finer feature resolution.

 − Better (denser) fills for thin-walls.

Thicker slices:

•	 Thicker layers produce faster builds.

•	 Fewer layers, which increases stairstepping.

•	 Thicker toolpaths (rasters and contours) for:

 − Faster deposition and shorter builds.

 − Stronger parts. 

5. FILE PROCESSING (INSIGHT)

Although Insight’s “green flag” defaults will produce acceptable, and 
usually very good, results, there are many user-level controls to consider. 
These options apply to both model and support. They are used to 
improve part quality and process throughput.  

The following file processing actions are commonly used to improve  
end-use parts while maximizing process speed.

5.1. Part orientation. (*) (Ae, St, Ti)

Part orientation is one of the few steps that must be competed for every 
part. Whether using the green flag defaults or customizing toolpaths, 
the first required action is part orientation. Yet, many give the impact 
and effects of orientation little thought. Although orienting to minimize 
the Z-height, and possibly build time, may be a viable strategy, there are 
other, equally important considerations (Figures 37 - 39).

5.1.1. Part orientation considerations.

•	 Strength.

 − Orient the part such that forces and loads are 
perpendicular to the slices. 

•	 Surface finish.

 − Orient the part such that contours are in the XY plane.

•	 Build time.

 − Orient the part to:

 à Minimize build height. 

 à Reduce the volume of support material.

 à Minimize the number of layers that contain both 
model and support.

Figure 37: Default orientation when opened  
in Insight.

Figure 38: Orientation for strength and  
minimal supports 

Figure 39: Alternative orientation.
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5.1.2. Orienting parts.

There are two recommended options in Insight to orient a part 
(Figure 40).

•	 STL > Orient by selected facet.

•	 STL > Rotate.

5.2. Build styles. (*) (St, Ti)

Insight offers three Part interior styles: Solid-normal, Sparse and 
Sparse-double dense. Select the appropriate style for the following 
characteristics:

•	 Strength.

•	 Weight.

•	 Material consumption.

•	 Build time.

Part interior style may be selected from Modeler > Setup or  
Toolpaths > Setup.

Following are descriptions and characteristics of the fill styles.

5.2.1. Solid-normal (Figure 41).

•	 Dense fill with no gap between adjacent rasters.

 − Rasters run perpendicular to those on the  
proceeding layer.

•	 Characteristics:

 − Strongest.

 − Heaviest.

 − Highest model material consumption.

 − Longest build times.

5.2.2. Sparse (Figure 42).

•	 Hollow interior with internal lattice for structural rigidity.

 − Large air gap between rasters.

 − Uni-directional rasters on each layer  (Figure 43).

 − Raster angle alternates between layers.

•	 Characteristics:

 − Weakest.

 − Lightest.

 − Lowest model material consumption.

 − Shortest build times.

Figure 40: Orientation dropdown menu 
offering Rotate and Orient by selected facet.

Figure 41: Part with Solid –normal fill.

Figure 42: Part with Sparse fill.

Figure 43: Sparse fill alternates raster direction 
for each layer.
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5.2.3. Sparse – double dense  (Figure 44).

•	 Hollow interior with internal lattice for structural rigidity.

 − Same as sparse, except bi-directional rasters on each 
layer (Figure 45).

•	 Characteristics (versus sparse):

 − Stronger.

 − Slightly heavier.

 − Slightly more model material.

 − Slightly longer build time.

5.2.4. Optimizing sparse fills.

For both Sparse and Sparse-double dense, several toolpath 
parameters can be changed to optimize weight, strength and 
build time. Make adjustments through Toolpaths > Setup > 
Advanced parameters or Toolpaths > Custom Groups > New/
Modify.

The most frequently changed settings are (Figure 46):

•	 Part interior depth: Thickness of the perimeter contours.

 − Default is the thickness of one contour. Increase to add 
strength to surface of part. 

Note: the total perimeter thickness will be the Part 
interior depth value plus two default contours—in 
addition to the depth value there will be two contours 
on the outside of the part. In the case of the default 
value (Part interior depth = 1) the total perimeter 
thickness would be three contours (1+2). 

•	 Part sparse solid layers: Number of slices above and below 
the sparse fill that will have a Solid-normal fill style. 

 − Default is four layers. Increase to add strength to the 
top and bottom surfaces.

•	 Part sparse fill air gap: Distance between rasters.

 − Default, which ranges from 0.060 in. to 0.100 in. ( 1.52 
mm to 2.54 mm), is dependent on material and tip size.

 − Increase to reduce build time and material 
consumption.

 à Can safely be increased to 250% of default value. 
Larger values are possible but adjustments may 
be needed for other parameters.

Figure 44: Part with Sparse – double dense fill.

Figure 45: Sparse – double dense fill uses 
crossing rasters on each layer.

Figure 46: Advanced parameters for sparse fills 
include interior depth, solid layers and air gap.
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5.3. Visible surface style (*) (Ae, Ti)

Set Visible surface style to Enhanced mode (Modeler > Setup).

Enhanced mode use small rasters for the toolpaths of external, visible 
surfaces. The visible surfaces also have a small negative air gap to press 
the rasters together (Figure 47). Internally, it uses thicker rasters with no air 
gap (Figure 48). The default values are listed in Table 3. 

This style improves surface finish while decreasing build time. 

Enhanced mode allows separate adjustment of raster widths and air gaps 
for the internal and external toolpaths. Accessed through Toolpaths > 
Setup > Advanced settings (Figure 49), they include: 

•	 Visible surface rasters.

•	 Visible surface rasters air gap.

•	 Internal rasters.

•	 Internal rasters air gap.

Material Tip Size Visible Raster 
inch (mm)

Visible Raster 
Air Gap  
inch (mm)

Internal 
Raster  
inch (mm)

Internal 
Raster Air 
Gap  
inch (mm)

ABS-M30, 
ABS-M30i, 
ABSi,  
PC-ABS

T-10 0.009 (0.23) -0.001 (-0.03) 0.016 (0.41) 0.000

T-12 0.012 (0.30) -0.001 (-0.03) 0.020 (0.51) 0.000

T-16 0.017 (0.43) -0.001 (-0.03) 0.024 (0.61) 0.000

T-20 0.022 (0.56) -0.001 (-0.03) 0.032 (0.81) 0.000

PC, PC-ISO T-12 0.012 (0.30) 0.000 0.020 (0.51) 0.000

T-16 0.017 (0.43) 0.000 0.024 (0.61) 0.000

T-20 0.022 (0.56) 0.000 0.032 (0.81) 0.000

PPSF T-16 0.017 (0.43) -0.001 (-0.03) 0.024 (0.61) 0.000

T-20 0.022 (0.56) -0.001 (-0.03) 0.032 (0.81) 0.000

ULTEM 9085 T-16 0.017 (0.43) -0.001 (-0.03) 0.024 (0.61) 0.000

T-20 0.022 (0.56) -0.001 (-0.03) 0.032 (0.81) 0.000

Table 3: Enhanced mode default settings.

5.4. Custom group: fill density/porosity. (*) (St)

Using the defaults for Contour style and Contour width across all features 
on an FDM part may result in porosity and air gaps. These voids will decrease 
the strength of features such as thin walls and bosses. For example:

•	 Thin wall: A single contour pass may leave an air gap if the distance 
between the contour’s sides is not large enough for a raster fill 
(Figure 50).

•	 Boss: At the contact points of the rasters with the contour, the 
raster turnaround will leave a small air gap. If tapping the boss, for 
example, the porosity would be exposed (Figure 51).

Eliminating the voids increases strength. To do this, custom groups apply 
user-defined values to the style and width of the outer shell, the contours, 
of individual features. The first approach uses the Contours to depth style.     

Figure 47: Enhanced mode produces thin 
rasters with a small negative air gap for smooth 
surfaces.

Figure 48: Internally, rasters are thicker, which 
reduces build time.

Figure 49: Parameters for Enhanced mode.

Figure 50: Defaults may produce voids in thin 
walls when rasters cannot fill between contours.
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Procedure:

5.4.1. Create custom group. 

Toolpaths > Custom groups > New. Give the custom group a 
Group name and click the checkmark to save it.

5.4.2. Calculate contour width.

To eliminate voids in a wall or boss, Insight needs a contour width 
that is an even multiple of the feature’s thickness since all curves 
must be a closed loop. For example, an 0.080 in. (2.0 mm) wall could 
potentially have a contour of 0.040 in. (1.0 mm), 0.020 in. (0.5 mm), 
0.013 in. (0.3 mm) or 0.010 (0.25 mm). So, begin by measuring* the 
feature and dividing its value by even numbers.

The next step is to confirm that the desired width is available for the 
job’s tip size. For a T16 tip, the 0.020 in. (0.5 mm) value is the only 
option. The available widths are visible in the dropdown menus of 
the toolpaths and custom group settings functions.

The selected width value becomes the Contour width setting in 
the next step.

*Measuring features:

•	 Display measurements  
(View > Measure data).

•	 Right click and select either Snap-measure  
or measure.

•	 Left click and drag over feature.

5.4.3. Define toolpath settings (Figure 52).

With the custom group displayed in the “Group Name” dialogue 
box, select Modify from the custom groups pane. Change 
Contour style to Contours to depth, which provides a user-definable perimeter thickness made from one 
or more contours.

Next, set the value for Contour width, which was 0.020 in. (0.5 mm) in the above example. Then set the 
Depth of contour equal to one-half of the feature’s thickness. In the example, this is 0.040 in. (1.0 mm). 

The result is a feature with both an inside- and outside-surface thickness of 0.040 in. (1.0 mm). 

5.4.4. Add curves to custom group.

Select all curves that will use the new custom group and click Add.

5.4.5. Generate toolpaths (Figure 53).

The last step is to generate toolpaths, shade them (Toolpaths > Shade toolpaths or right click > Shade 
toolpaths) and view them. The result should be solid fills with no gaps between rasters. If gaps exist, adjust 
the custom group values accordingly.

Figure 51: Defaults may produce porosity are 
the point of turnaround.

Figure 52: Custom group settings for solid fills 
using Contours to depth.

Figure 53: Result – solid fill for boss.
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This type of custom group can also create features with an 
internal raster bounded by the user-defined Contours to depth.  
The next approach to eliminate air gaps is very similar, but it uses 
the Perimeter only style, which can have only one contour.

Procedure:

5.4.6. Create custom group.

Follow the instructions for 5.4.1 and 5.4.2. For the latter step, 
divide the measurement by 2 only.

5.4.7. Define toolpath settings (Figure 54).

From the custom groups window, select Modify. Change 
Contour style to Perimeter only, which provides a user-definable 
perimeter thickness made from one contour. Next, set the 
Contour width value to that calculated in 5.4.6.

Note that this method would not work with a 0.080 in. (2.0 mm) 
feature using a T16 tip. The necessary value (0.040 in./1.0 mm) is 
not an option for this tip size.

5.4.8. Add curves to custom group.

Select all curves that will use the new custom group and click 
Add.

5.4.9. Generate toolpaths (Figure 55).

The last step is to generate toolpaths, shade them (Toolpaths 
> Shade toolpaths or right click > Shade toolpaths) and view 
them. The result should be solid fills with no gaps between 
rasters. If gaps exist, adjust the custom group values.

5.5. Custom group: gradual slopes. (**) (Ae)

On surfaces with a gradual slope, default toolpaths may produce visible 
pin holes at the point of raster turnarounds. This happens when the offset 
of a layer is larger than the contours of the layer below (Figure 56). To 
conceal the raster turnarounds and have a solid external surface, create 
and apply a custom group to the affected slices (Figure 57).

Procedure:

5.5.1. Create custom group. 

Toolpaths > Custom groups > New. Give the custom group a 
Group name and click the checkmark to save it. 

Note: Do not give the group a name that already exists; all other 
curves with that name will be overwritten.

5.5.2. Modify toolpath settings.

To conceal the raster turnarounds, increase the contour depth 
such that it overlaps with the contour for the layer above it.

Figure 54: Custom group settings for solid fills 
using Perimeter only.

Figure 55: Result – solid fill for thin walls.

Figure 56: On shallow slopes, raster 
turnarounds may be visible (left). Custom 
groups can correct this (right).

Figure 57: Area of interest (gradual slope) 
shown in this section view.

Figure 58: Select the curves in the area of 
gradual slopes (blue) and apply custom group.
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Select Modify from the custom group window. Change Contour 
style to Contours to depth. Next, increase the Depth of 
contours value; make it large enough inset the rasters below the 
contours for the next layer.

5.5.3. Add curves to custom group (Figure 58).

Select all curves on the gradual slope surfaces and click Add.

5.5.4. Generate toolpaths.

After generating toolpaths, shade them (Toolpaths > Shade 
Toolpaths) and view all affected layers. Use the View layer 
plus layer above/below setting to see if all raster turnarounds 
are concealed by the layer contours (Figures 59 and 60). If 
adjustments are necessary, return to the Modify function and 
adjust the Depth of contours value. 

5.6. Custom group: supports made with model material. (**) (Ti)

Although it takes only a few seconds per layer, the time to switch between 
model and support material can have a noticeable impact on throughput. 
The increase in build time becomes more significant as the number of 
layers increase.

To eliminate this time from the build, create a custom group that 
constructs supports from model material. 

Apply this technique when there are a large number of layers with 
both model and support curves (Sparse style) and when the supports 
are accessible and easily removed. In addition, this technique is only 
applicable for layers that contain just part curves (red) and SupportSparse 
curves (gray). To determine if these conditions exist:

•	 Generate supports.

 − After slicing the file, set Support style to SMART or Sparse 
(Support > Setup). Then click the Create supports icon.

•	 View slices (Figure 62).

 − Scroll through all the slices. Look for:

 à Layers with only model (red) and sparse/SMART 
supports (gray).

 à Supports curves that that can easily be removed.

Avoid supports that surround model curves and 
supports that are surrounded by model curves. With 
either condition, the supports will be difficult to remove 
without damaging the part.

To swap model for support material, use the following procedure: 

5.6.1. Create custom group. 

Toolpaths > Custom groups > New. Click the Templates icon 
and select SupportSparse from the Template group menu (Figure 
63). Click the checkmark.

Figure 59: View toolpaths using the two-layer 
view to see if raster turnarounds are concealed. 
In this illustration, they are not.

Figure 60: With correct Contours to depth 
settings, the turnaround is concealed.

Figure 61: Visible turnarounds (left) from 
default settings. Concealed turnarounds (right) 
with custom group.

Figure 62: View slices to find those with only 
support (gray) and model (red).

Figure 63: Create custom group using a 
template for SupportSparse.
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By using the template, the new custom group inherits all of the 
toolpath settings from SupportSparse.

5.6.2. Modify toolpath settings.

The only setting that will change is Toolpath material. To make 
supports from model material, simply select Model from the 
dropdown menu (Figure 64).

Give the custom group a Group name and click the checkmark to 
save it.

5.6.3. Add default support curves to custom group.

Select only the support curves (gray) that are accessible and 
removable. DO NOT add basic supports (gold) or support 
interface (green) curves.

After selecting the curves, click Add from the custom groups 
window (Figures 65 and 66).

5.7. Custom group: wide supports (**) (Ti)

The default settings for supports create a strong, rigid structure made 
from soluble or breakaway support material. To reduce the volume of 
supports, and therefore the time to construct them, increase the air gap 
between each support raster (Figures 67 and 68). 

The wide support procedure is defined in a custom group that increases the 
air gap and replaces support material with model material (Figures 69 and 70).

Apply this technique when there are large, tall groupings of 
SupportSparse towers—or more generally, a lot of SupportSparse 
surface area— that are accessible and do not surround any model features 
(Figure 71). 

Procedure:

5.7.1. Create custom group 1. 

Toolpaths > Custom groups > New. Click the Templates icon 
and select SupportSparse from the Template group menu and 
click the checkmark.

By using the template, the new custom group inherits all of the 
toolpath settings from SupportSparse.

5.7.2. Modify toolpath settings (Figure 72).

Change Toolpath material to Model so that the supports will 
have the strength to support the part. Next, set the Start angle to 
-30° (90° counterclockwise from the default angle).

The last setting adjusts the Adjacent rasters air gap by increasing 
the spacing between the support rasters. This value can be up to 
0.75 in. (19.1 mm) with no other alterations.  

Give the custom group a Group name and click the checkmark to 
save it.

Figure 64:Change Toolpath material to Model. 

Figure 65: Select the curves for the supports 
that will be made from model (white).

Figure 66: Apply the custom group (green) to 
build supports from model material.

Figure 67: Support tower with wide air gaps to 
decrease build time.

Figure 68: Top-down view shows wide spacing 
between support rasters.

Figure 69: Default Sparse support toolpaths (right).

Figure 70: Wide air gap supports (right).
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5.7.3. Create custom group 2. 

Toolpaths > Custom groups > New. Click the Templates icon 
and select SupportSparse from the Template group menu and 
click the checkmark.

5.7.4. Modify toolpath settings (Figure 73).

Use the same settings as in Step 5.7.2 for Toolpath material 
(Model) and Adjacent rasters air gap.

Set the Delta angle to 90° and the Layers 
between delta to 99. These settings place 
a layer of support that runs perpendicular to 
the 99 layers below it. This acts as a cross-
member that keeps the support column rigid 
and stable

Give the custom group a Group name and 
click the checkmark to save it.

5.7.5. Add curves to custom groups.

After selecting and applying the custom 
groups, the support columns should build 
with the following order of toolpaths  
(Figure 74):

•	 Bottom 10 layers: Custom group 1 (-30° raster angle).

 − The wide supports cut across the defaults supports  
(if parallel to them, they would “fall through the cracks”). 
(Figure 75)

•	 Middle layers: Custom group 2.

 − First 99 layers (counted from the 
first part layer): -30° raster angle.

 − Next layer: 60° raster angle.

This set of alternating raster angles 
repeats every one hundred layers 
and stops when only 10 layers 
remain.

•	 Next 10 layers: Custom group 1  
(-30° raster angle)

 − To form a bridge for the final 
layers.

•	 Top 10 layers: Default supports.

This is the transition zone where 
the support style returns to that 
used for all other supports in 
the file and where the change to 
support interface occurs.   

Figure 71: Select support towers that are 
accessible and do not surround part features.

Figure 73: Custom group 2 adjustments.

Figure 74: Toolpath regions after applying custom groups 1 and 2.

Figure 72: Settings for custom group 1.
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To establish this pattern, locate the layers that contain the support 
curves that will use wide air gaps. Next, set the Range top to 10 
layers below the top of the supports and Range bottom to the 
bottommost layer of supports. Now, display this range by clicking 
on View range of layers. 

Select the bottom 10 and top 10 layers for the range and add 
them to custom group 1. Then select all remaining layers in the 
range and add them to custom group 2. For parts with many 
features, selection may be easier if some model curves are hidden 
(View > Hide curves). To further simplify selection, use the 
Selection tools (Figure 76) that appear in the custom group pane 
(e.g. by group name, color or curve type).

6. THROUGHPUT & PRODUCTION PLANNING

When compare to conventional manufacturing processes, FDM is unique 
in several ways:

•	 It can operate as a self-service process.

•	 It can build a variety of parts in a single operation.

•	 It is an unattended operation.

This uniqueness offers advantages but only when they are leveraged. To 
do so, a change in thinking and operational style may be needed. When 
scheduling an FDM system, consider the following:

•	 No setup (changeover) time required (Figure 77).

 − Small batch runs and one-off builds are economical and 
efficient. So, parts may be built one at a time and as needed.

•	 Production mix is unlimited (Figure 78).

 − Build any combination of parts, prototypes and manufacturing 
tools.

 − Combine work for multiple staff members, departments or 
divisions.

•	 Multi-piece runs increase throughput.

 − By sharing the operational overhead, such as the time to 
purge a tip, the time per part decreases.

•	 Tallest part carries most of the process overhead.

 − Much of the operational overhead is dictated by the 
height of the tallest part. So, a second copy of it, or adding 
shorter parts, will add far less time than that to build them 
separately. 

•	 Builds can be matched to shift schedules (Figure 79).

Figure 76: Use the selection tool when 
selecting curves.

Figure 77: Build small lots of parts, even one-
off, without concern for setup and changeover.

Figure 78: Combine multiple parts, in any 
combination, for building.

Figure 79: Maximize throughput with multi-part 
builds.

Figure 75: Wide supports in custom group 1 
run perpendicular to default supports.
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 − To maximize throughput, consider the shift schedule when 
laying out builds, launching runs and planning the production 
schedule. A five-hour build started at 4:00 pm may mean an 
idle machine for 11 hours. 

 − Create jobs that fit with the start and stop times of working 
shifts; jobs that will consume the better part of a weekend; 
and jobs that will run over a long, holiday weekend. It is 
inefficient to end a build when there is no staff available for 
change-over. 

The production planning and scheduling tools are:

•	 Control Center

•	 Insight

6.1. Packing the build sheet. (*) (Ti)

This operation is basic and routine. Yet, it is important enough to 
reiterate.

In Control Center, add individual jobs (saved from Insight) to maximize 
throughput while balancing the build time with the working schedule of 
those that will remove the parts and start the next build.

Procedure:

6.1.1. Create a pack.

While in the Control Center Pack tab, click Insert CMB and 
browse for the desired file. Click Open (Figure 80). Repeat until 
all desired parts are in the pack.

6.1.2. Optimize the pack.

To add duplicates of any part in the  
pack, click Copy. Next, arrange all parts 
by clicking and dragging, rotating or 
Repacking. 

6.1.3. Monitor the estimated time in the Pack 
Details window.

Adjust the time to match the production 
schedule by adding, copying or removing 
parts from the pack (Figure 81).

6.2. Nesting parts. (***) (Ti)

Control Center prevents parts from imping on other parts’ bounding 
volumes. It also optimizes the travel of the extrusion head for individual 
parts rather than planning the path for the collection of all parts.

Figure 80: In Control Center, insert CMBs to create 
a pack.

Figure 81: Duplicate or add parts and then place 
them in the pack.

Figure 82: Sample production schedule that accounts for shift schedules 
and weekends.
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To optimize build packing and extrusion head travel, nest part files in 
Insight (Figure 84) prior to sending them to Control Center. Using this 
technique, parts can be stacked, overlapped and nested. One example is 
the placement of a part in a center void of another, as would be seen with 
a torus (donut shape). 

Procedure:

6.2.1. Open and slice part 1 (Figure 85).

Save the job file (File > Save as > Job).

6.2.2. Open and slice part 2 (Figure 86).

6.2.3. Add part 1 to part 2’s job file (Figure 87).

•	 Slice > Combines slice curve files.

•	 Click Slice file field and select part 1.sjb file.

•	 Place part 1.

 − Click and drag to a new location or enter coordinates 
in Slice curve location fields.

•	 Click OK to add the part.

 à Note, if placement needs adjustment after the part 
has been added, use the Edit > Move, rotate, copy… 
function. 

6.2.4. Create toolpaths and supports.

6.2.5. Save toolpaths.

•	 File > Save as > Toolpath. 

This creates a .cmb.gz file, which is commonly called the “CMB.”  
To build this set of nested tools later, while in Control Center, 
select Insert CMB. Then process the build as usual.

7. RECAP - CRITICAL SUCCESS FACTORS

7.1.  Leverage advantages of additive manufacturing.

•	 Complex structures, including part consolidation.

•	 Design liberties.

•	 Redesign and revision frequency.

•	 Automated, lights-out operation.

•	 Small-lot, on-demand production.

•	 Lead time and cost reduction.

Figure 86: Open and slice the second part 
(example duplicates a single part). 

Figure 87: Combine the job files

Figure 84: CAD model for nested part.  

Figure 85: Open and slice the first part.

Figure 83: Note that the incremental time 
reduction will decline as parts are added.
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7.2. Invest time accordingly:

7.2.1. Pilot production.

Light adjustments.

7.2.2. Bridge-to-production.

Moderate adjustments and some optimization.

7.2.3. Full production.

Complete redesign and full optimization.

7.3. Optimize jobs for:

•	 Strength.

•	 Aesthetics.

•	 Maximum throughput/minimal time.

•	 Lowest piece-part cost.

To obtain a file for the sample part, or to obtain more  
information on this application, contact:

Stratasys Application Engineering

1-855-693-0073 (toll free)

+1 952-294-3888 (local or international) 

ApplicationSupport@Stratasys.com


